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Configuring Settings for IE, Firefox, Safari and Google 

 
Configuring Settings for Microsoft Internet Explorer 

An updated was done to Internet Explorer in Mid December 2015 
DO NOT USE INTERNET EXPLORER!!! 

and PRIMAVERA Unifier does not work with it. 
 
 
Configuring Settings for Mozilla Firefox    
https://www.mozilla.org/en-US/ 
1) Open Mozilla Firefox.  
2) Open Options.  
3) In the Options dialog box:  

a. Select the Content tab.  
b. Deselect (Uncheck) the Block pop-up windows option.  
c. Click OK to save your options and close the dialog box. General Setup Tasks  

 

 
Configuring Settings for Apple Safari  

1) Open Apple Safari.  
2) From the Settings dropdown, select Preferences.  
3) In the General dialog box, select Security.  
4) In the Web Content section, deselect (Uncheck) Block pop-up windows.  
5) Close the dialog box.  
 

1) In Google click on the Screen with the x in the Address Bar (See below) 

Configuring Settings for Google Chrome 
https://www.google.com/chrome/browser/desktop/index.html 

2) Change it to “Always allow pop-ups from cosaprimelink-unifier.oracleindustry.com” 

 
 

If you have already being using Google Chrome,please do the following – 

1)  Click on the 3 horz lines in the upper right hand corner      
2)  Click on Settings, Type pop in the “Search settings” box 
3)  Under Privacy, click on “Content Settings”, Scoll down to “Pop-ups” 
4)  Put a dot in “Allow all sites to show pop-ups 
5)  Click on “Done” in the lower right hand corner 

https://www.mozilla.org/en-US/�
https://www.google.com/chrome/browser/desktop/index.html�
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Logging into the new ORACLE Access Manager 
 

To login into ORACLE Access Manager, go to https://cosaprimelink-unifier.oracleindustry.com 
   

Main Logon Page 

 
 

You will enter your username that you used in PRIMELink and  
                                              the new password that Oracle or that we sent to you in the email 
 
After you have click on Login, this page will show up.   
Please change your password and select and answer the Challenge Questions.   
 
Your old password is the one Oracle or we told you.  (NOT YOUR OLD PASSWORD) 
 
(Passwords should be at least 8 characters long, with at least one capital letter & one special character  

[{~!@#$%&*()-_=+;:"’,<.>/?}] 
 

Password Change and Secret Question Page 

 

If you get a “Do you want to save your password for this site”?  Say NO or NOPE 

https://cosaprimelink-unifier.oracleindustry.com/�


4 

 
After you have click on “Submit
1.  To go into PRIMELink Unifier, click on Unifier 

”, this page will show up.   

2.  To change your password or change your proxy, click on OIM Identity 
 
 

 

Click this Icon to open PRIMAVERA Unifier 
Or on the words - Unifier 

To change user information such as 
Name, Email, Password, Challenge Questions & Proxies 

Click on the Oracle Identity Manager 
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If you need to change your Password later 

1. To login into ORACLE Access Manager  
2. Click on OIM Identity  

 
• 1.  Click on My Information,  
• 2.  then on Change Password 
• 3.  Input your current password in Old Password and input your new password twice then click on “Apply” 

 
 

1.   

2.   
 

3.   
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Change Attachment Preferences  

To be able to attach documents to PRIMELink please do the following: 

You must be in PRIMAVERA Unifier, (NOT OIM Identity) 

 
1. Click on your name in the upper right-hand corner 

2. Click on Preferences, click on Options, and  

3.  Make sure the “File Transfer Option”: in on “Basic”  

Check “Always Use Unifier”, make sure it has - dwg:dgn  

Do not change the checkmarks!!! 
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Home and Project pages Change Views of Dashboard 

1.  The first time you go into PRIMAVERA Unifier the COSA tab may show the Map View 
Click on the Collapse View .  That will bring up the Dashboard  View at the bottom 

 
 
2.  Then to expand the Dashboard view, Click on Expand View on the other small box 

 
 
 

Collapse View 

Expand View 
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4.  Once in a project, in the upper right hand corner click on the Dashboard view 

 
 
You can move items around now in this view.  By click clicking on one of the four boxes 
and moving it to a different location. 
 

Dashboard View 
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One of the biggest changes to PRIMELink Unifier are the following items -  
 
 
PRIMELink  has some minor changes to the layout.  
 
Users will have the same three tabs (Home, Company Workspace and CoSA);  
 
However, additional tabs can be added to include projects or on-call contracts.  
 
See below for additional changes. 
 

  
 
 
The PRIMELink system has a search bar to navigate to your projects and on-call contracts. To use this 
function, enter a project or contract name in the “Navigate To…” field.  
Users can still drill down by using CoSA tab.  
 

 

Click on Star 
for Bookmarks 

Click on “+” to 
add Tabs 

Click icon to go 
back to Home tab 

Click on name 
for Preferences 
and Proxy 

New Email Address for 
Project Mailbox 

Type project or contract name in this field 
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When you click on Tasks you will see something like the below: 

 
 

• Tasks

o A new task appears in BOLD  

 displays all tasks that you have received. Tasks include items that require 
review, approval, comment, etc.  

o A late task appears in RED 
o A previously viewed task but not completed appears in normal font 

• Messages
• 

 displays copies of items which you have been cc’d 
Drafts

• 
 displays saved drafts of items you have created but not sent 

uMails
 

 displays internal e-mail messages sent within the system 

 
View Pending Tasks 

Click on the Home Tab 
All Tasks: 

Select Task 
 

Go to your project or from Home tab click on project 
Project Specific: 

Select Task from the Dashboard 
 

Tasks 
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View Draft Records 
 

When you start a new item in PRIMELink and you have to get out, sometimes the system 
will store it has a Draft Record.  Please keep an eye on this item.  You do not want to have 
a lot of Draft Records.  To clear them do the following:  

1.  Click on Draft Records in the upper right corner 
2.  Highlight one line (you can only do it one at a time) 
3.  Click on Delete on the bar above 
4.  Continue until all the Drafts have been deleted. 

 
 
CoSA Tab 

 
The CoSA tab contains all the current On-Call Contracts and Projects. You need to go to 
the far right side of the screen and select either: On-Call Contracts or Project.                                                                                              
    

Select either 
On-Call Contracts 

or Project 
 or Task Order 

Contracts Group 

Click Expand View 
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Modify CoSA Tab 

 

Letters before Project Names stand for the following: 

A – Aviation Projects 
B – Building and Equipment Services 
E – Environmental On-Call Contracts 
F – Traffic Management/Operations Projects and On-Call Contracts 
H – CIMS and Public Works Horizontal Projects and On-Call Contracts 
J – JOC On-Call Contracts 
K – Parks Department Projects 
P – Public Works On-Call Contracts and Projects 
R – Real Estate On-Call Contracts 
T – Technical Services On-Call Contracts 
V – CIMS Vertical Projects and On-Call Contracts 

VS – Convention Center Expansion Projects and On-Call Contracts 
 

Bookmarks 

1. To put Contract or Project Names in order 
Click on the column header 

 

2. To see more items per page  
Click on the Display  

 

3. To open your Contract or Project  
Click on the name 
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You can create Bookmarks to frequently accessed Projects or On-Call Contracts. 
 

1. Navigate to the desired Project or On-Call Contract 
2. Click the Bookmarks Star on the upper left section of the window 
3. Click Add to create the bookmark                                                          

 
 
If you want PRIMELink to open at your project, click on Organize then put a Checkmark in 
the Default Logon block.   

 

Bookmarks 
link 

Click “Add” to create 
Bookmark 
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Action Details 

Upper Form 

Lower Form 

PRIMELink Forms 

You will be completing forms by entering information into form fields or selecting options 
through pickers, drop-down lists, and check boxes. 
 
PRIMELink forms consist of one or more sections: Upper Form, Action Details, and Lower 
Form. 
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Upper Form 
 

The upper form contains basic information. Fields in all forms will vary: editable, required, 
and read-only fields. 
 

• Editable fields are shown by a white background text box 
• Required fields are shown by a red * after the field 
• Read-only fields are show by a blue-gray text box 
• Pickers allow selecting from a list of options. Once selected, a dialog box will 

appear allowing to select from a list. 
 

 
 

 

If you received a Task  
You must either click on  
Accept Task or Decline Task 

Read-only field 

Required field 

Editable fields 

Picker 

Click here to expand  
upper form 

If Workflow Actions is shown 
an input is required to send  
your item to the next step 
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Action Details 
 
An action detail shows that the task will be assigned to in the next workflow step,  
who it will be emailed to and workflow status. 
 

 
 
 
 
 

 
 
 
 

Depending on the 
setup, the To and  
Cc boxes will 
auto-populate 

Task Notes apply only  
to the next step and 
are not stored with  
the permanent record 

Task Status: Click on  
View Only to see where 
the item is in the workflow 

Task Notes apply only  
to the next step and 
are not stored with  
the permanent record 
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Lower Form  
 

The lower form contains fiscal information and has the main content of the record, such as 
line items for a payment request, attachments, comments or directions. The following is an 
example of a List Items list. 
 

 
Help Files in PRIMELink 

On some items there Help Files at the top, to see if there are help files on an item,  
do the following:  (You must be on your project and on the item you want help with)  
(The User, Admin and Reference Guides are from Oracle and not the PRIMELink 
Helpdesk these will not help you with your problems) 

Task Request Contracts Group Help, Field Work Directive Help,  
PRN Help, RFIs Help 

Are just some of the help files that have a PDF help file.   
Most do not have a help file yet. 

Click to view 
Attachments 

Click to add/view 
General Comments 

Click to add other 
lines of information 

Double click to view/edit  
this line of information 
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Workflows 

Most business processes in PRIMELink have an associated workflow. When you take and 
action on a form, you are completing a step on the workflow.  
 
Below is a Request for Information (RFI) 

Workflow:  
Assign Task in Workflow 

 
You can assign a task to someone else assuming it is allowed. 
 
1. Open and Prior to accepting a task 
2. Select Edit  
3. Select Add Assignee to Current Step 
4. Select the person 
5. Click on Add 
6. Click Ok 
 
You will receive a message – “New assignees have been added to ….” 
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Add a Proxy 
 

Proxy will be utilized when you would like to permit someone else to process items in your 
absence. 
 
1. Click on your name in the top right corner of the page 
2. Click on Preferences 
3. Click on Proxy tab 
4. Click on Add 
5. Click on Select 

• Click on Find, Input the first or last name of the person, click Search 
• Select the name 
• Click on Add 
• Click Ok 

6. Enter Start & End Dates (optional) 
7. Click Ok 

 
 

Remove Proxy 
1. Click on your name in the top right corner of the page 
2. Click on Preferences 
3. Click on Proxy tab 
4. Highlight the name 
5. Click Remove 
6. Click Ok 
 

Login as a Proxy 
 

1. Click on your name in the top right corner of the page 
2. Click on Preferences 
3. Click on Proxy tab 
4. Highlight the name under –  

Users I can act as their proxy 
5. Click Proxy Logon 
6. You will logon on their behalf 
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User Access Request Form 
 

This form will be used by the PRIMELink Helpdesk to grant and remove access within the system and track who 
requested/authorized the user’s access. 
 

• Form must be completed by the requestor/authorizer within PRIMELink in order to request, remove or 
modify a user’s access to the system. 

• Only personnel who already have PRIMELink access will be able to request/authorize access. 
• User Access form functions as other PRIMELink forms, i.e. form is completed, a Workflow Action is selected 

and to initiate workflow action the user is required to click on Send action button.  Note: Users are able to 
copy from previous requests or individual line items within the form tabs. 

• A single request can be used to request accounts for more than one person, assign a person to more than 
one project, assign multiple people to multiple projects or assign people to both Projects and On‐Call 
Contracts. 

 
1. Logon to PRIMELink 
2. Click on Company Workspace Tab, click and expand Company Logs line and double-click on the User Access 

– Company business process. 

 
3. Click New icon on action bar in active window to create a new request 
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4.  On the Header part of the User Access form, denote in the Remarks text field, a brief description of what the 
access request will entail and/or any other information that will be helpful in understanding the request(s). This 
information is used by the Helpdesk personnel to determine what needs to be done. 

Notes: 
• The Header identifies who is requesting/authorizing the user access. 
• The fields (i.e. record number, status, and creation date) in the Header part of User Access form are 

auto‐populated once the request is submitted. 
 
5.  Click on the appropriate Action Details Tab(s) to open up the detail portion of form for completion, see Steps 
5a – 5d. 

Notes: 
• There are four Detail Forms with tabs entitled  

Accounts, Projects, OnCall Contracts and Templates.   
User can use more than one tab on a single request. 

• The type of access request determines which tab(s) will need to be completed.   
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5a. Click on Accounts Tab, to add, delete or modify a user’s PRIMELink account.  
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the Account Tab detail section.  
 

1. Select Add from Action drop‐down list.  
To Add User Account 

IF THE PERSON ALREADY HAS ACCESS TO PRIMELink, DO NOT USE THIS! 

2. User Access Account window will appear. Must complete all of required fields (marked with red 
asterisk *) 

GO TO ONE OF THE OTHER TABS 

3. Ignore the Name field (i.e. user will be unable to find name in name list since access has not been 
established yet) and complete the remainder of the fields in the account information tab. 
4. For Non‐City Employee Account(s) - Please attach the appropriate agreements and answer the 
questions in the New Non‐City Accounts section. If this is the first PRIMELink account for the business, 
then a Business Agreement is also required. Both agreements are available at 
http://www.sanantonio.gov/CIMS/CurrentVendorResources/COSAPrimeLink.aspx 
Note: An individual user agreement is required for every non-city employee requesting an 
account. 
 
5. For City Employee Account(s) - Complete the New City Accounts section. Note: If your department or 
division is not on the list, put the information in the remarks field. The user id is the same as your COSA 
computer logon id. 
6. In remark field, enter any other information that will be helpful for the Helpdesk. 

 
To Delete User Account 

1. Select Delete from Action drop‐down list. 
2. Use the Name field selection button to find the user you want to delete. Once selected the remainder 
of the information will be filled out. 
3. Denote in Remarks field, if this person was on any workflows or other considerations such as 
replacing this person with someone else in the workflows. 
Note: This action will prevent the user from accessing system for any project. If you want to remove 
person from a select project or on‐call contract use the Projects or On‐Call Contract tabs. 

 
To Modify User Account 

1. Select Modify from Action drop‐down list. 
2. Use the Name field selection button to find the user you want to modify their profile information.  
Once selected the remainder of the information will be filled out. 
3. Denote in Remarks field, what changes you want the Helpdesk to make on the user’s account. 
Note: Use this action to change phone numbers, emails or other account information. This will not 
change what projects or on‐call contracts the person has access to. 

 

http://www.sanantonio.gov/CIMS/CurrentVendorResources/COSAPrimeLink.aspx�
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5b. Click on Projects Tab, to add, delete or modify a user’s PRIMELink account access to a project. 
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the Project Tab detail section. 
 
Note: A separate line item is required for each user/project combination. If you need to give a person access to 
several projects, create the line item for the first project, then copy the line item, open the new line item and change 
the project along with any change in remarks. 
 
Add, Delete or Modify User Account Access to Project 

1. Select appropriate action from Action drop‐down list: 
a. Add – if user wants to add user access to a project 
b. Delete – if user wants to remove user access to a project 
c. Modify – if user want to change what a user role on a project 

2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the 
remainder of the information will be filled out. Note: If the user does not yet have an account you will have 
to type in the first name, last name and company fields. 
3. Choose the Project Role that best fits the user. 
4. Use the Project ID selector button to find the project. Note: If you can’t find the project, manually enter 
the project name into the Project Name field. 
5. Denote in Remarks field, a brief description of what the person will be doing on the project. 
This is used by the Helpdesk personnel to determine exactly which groups within the project the person 
needs to be in. The groups determine what the user is able to see and do. 
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5c. Click on On-Call Contracts Tab, to add, delete or modify a user’s PRIMELink account access to an on‐call contract.  
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the On-Call Contracts Tab detail section. 
Note: A separate line item is required for each user/on‐call Contracts combination. If you need to give a person access 
to several on‐call Contracts, create the line item for the first on-call Contracts, then copy the line item, open the new 
line item and change the on‐call Contracts along with any change in remarks. 
 
Add, Delete or Modify User Account Access to On-Call Contracts 

1. Select appropriate action from Action drop‐down list: 
a. Add – if user wants to add user access to a on‐call Contracts 
b. Delete – if user wants to remove user access to a on‐call Contracts 
c. Modify – if user want to change what a user role on a on‐call Contracts 

2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the 
remainder of the information will be filled out. Note: If the user does not yet have an account you will have 
to type in the first name, last name and company fields. 
3. Choose the On‐call Contracts Role that best fits the user. 
4. Use the On‐call Contracts ID selector button to find the on‐call Contracts. Note: If you can’t find the on‐call 
Contracts, manually enter the on‐call Contracts name into the On‐call Contracts Name field. 
5. Denote in Remarks field, a brief description of what the person will be doing on the on-call Contracts. This 
is used by the Helpdesk personnel to determine exactly which groups within the on‐call Contracts the person 
needs to be in. The groups determine what the user is able to see and do. 
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5d. Click on Templates Tab, to add, delete or modify a user’s PRIMELink account access on templates. 
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the Templates Tab detail section. 
 
Note: This detail tab is used for only those individuals in  
Fiscal, Contract Services, Director’s Office, Division Managers, Utility (SAWS/CPS Energy) and TxDOT access groups. 
 
Add, Delete or Modify User Account Access to Templates 

1. Select appropriate action from Action drop‐down list: 
a. Add – if user wants to add user access across all existing projects 
b. Delete – if user wants to remove user access from all existing project workflows  
(i.e. project templates) 
c. Modify – if user want to change what a user’s role on project template 

2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the 
remainder of the information will be filled out. Note: If the user does not yet have an account you will have 
to type in the first name, last name and company fields. 
3. Choose the Template Role that best fits the user. 
4. Denote in Remarks field, a brief description of what the person will be doing on the On-Call Contracts. This 
is used by the Helpdesk personnel to determine exactly which groups within the on‐call Contracts the person 
needs to be in. The groups determine what the user is able to see and do. 

 

 
 

6.  Upon completing the appropriate detail tab(s) part of the form. Select Submit in 
Workflow Action list and click on Send. 
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Reports – User-Defined and Custom Reports 
 
There are many reports in the PRIMELink system that you can use to find out information about your Project 
or On-Call Contract current items.  To find out want reports are available to you do the following: 
 

1. Go to your Project or On-Call Contract 
2. Go to the bottom of the menu and click on “Reports” 
3. Select “User-Defined” or “Custom Report” 
4. Under “User-Defined” you may see the following: 

 

 
 

5. Under “Custom Reports” you may see the following: 
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6. Under each report you will find a different kind of request page – 

 
a. Next to Agency you can click on Select, you will see this 

 Click on the one you want or leave it blank 
b. Same for Type of Contract  

 Click on the one you want or leave it blank 
c.  At the bottom, select either CSV or PDF. 

i. CSV will give you a spreadsheet of the items 
ii. PDF will give you a PDF of the items. 

 
7. Click on Run to get the report you are requesting. 
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If you are using Google Chrome cannot view a PDF file in PrimeLink, it could be because Google 
Chrome has its own version of a PDF Viewer and it needs to be disabled! 
 
To do that: 
 

1) Right click on Google Chrome icon 
2) Click on the Google Chrome name 
3) In the top message bar are, type in “about:plugins” and hit Enter 
4) Click on Disable Chrome PDF Viewer 
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